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Harrison Mixbus Virtual Broadcast Mixer (VBM)

1.0 Introduction

Harrison Mixbus VBM is a cloud-ready virtual broadcast mixer.  Based on Harrison Consoles 
decades-long experience producing analogue and digital mixing consoles, VBM uses software 
mixing technology developed for Harrison's Mixbus DAW platform.

Figure   1  : VBM CONTROL PANEL

Mixbus VBM runs on MAC, Linux and Windows platforms.

1.1 Premise

Mixbus VBM is a computer based digital mixer for live broadcast mixing applications. It is 
tailored to applications that require multiple mix minus feeds and can provide multiple program 
outputs. It can be run locally or on a remote virtual server.  Audio inputs and outputs to VBM are 
over network connections and are not necessarily local to the broadcast engineer's physical 
location.
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2.0 Overview

Figure 1 shows the VBM control panel.  In the figure left to right, there are 6 basic sections to 
the panel.

1. Input and Bus List
2. Input Section
3. VCA Masters
4. Mix Minus Buses
5. Program Buses
6. Monitor Section

The Input and Bus List is selectable and can be hidden if not needed.  Additionally, VCA 
masters will not be displayed if none have been created. 

2.1 Input Section

Figure 2 shows the input section of Mixbus VBM.  The input section is comprised of several 
channel strips, the number of which is limited only by the amount of your computing power.  
Channel strips are added by creating Inputs or Contributors.

Channel strips may be either mono or stereo.  The ones shown in Figure 2 happen to be 
stereo.

At the top of the input section are 4 buttons.  They are:

1. Template – This button is used when starting VBM for a new project. It provides a fast 
method of configuring a full mixing session based on a preset list of channels and 
names. The user can either accept the defaults or modify them as needed. Once ready, 
pressing the OK button will create the selected channels in the mixer in one step. 

2. Add Contributor – 

DEFINITION: A "Contributor" is an audio source that has a MixMinus bus corresponding
to its input channel.

This button adds both an input channel and a corresponding MixMinus bus.  The 
contributor may be either stereo or mono.

3. Add Input – This button adds an input channel.  The input may be either stereo or 
mono.  No MixMinus bus corresponding to this input is created.

4. Add VCA – This button adds a VCA master.  When a VCA master is created, all 
channel strips have a VCA assign button added at the bottom.  See Section 2.2.14.
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Figure   2  : VBM INPUT SECTION
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2.2 VBM Channel Strip

Figure 3 shows a VBM channel strip.  When a channel strip is created it can be chosen to be 
either stereo or mono.  The channel strip in Figure 3 is a stereo channel strip.  The mono channel 
strip is shown in Figure 4 and is identical except for a pan control rather than a balance control 
(see Section 2.2.6), and the level meter is a single meter rather than a pair of meters.

Features and functions of the channel strip are presented in the following sections.
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Figure   3  : VBM STEREO CHANNEL STRIP
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Figure   4  : VBM MONO CHANNEL STRIP
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2.2.1 Name Plate

The name plate has the name of the channel.  Right OR left clicking on the name plate 
provides for renaming, changing colours and other controls.

Figure   5  : CHANNEL NAME PLATE FUNCTIONS

The "Comments" selection allows entry of notes or comments specific to this channel.  Once 
entered they may be read at any time by accessing this selection again, as shown in Figure 6.

Figure   6  : CHANNEL COMMENT BOX
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"Pin Connections" brings up a window where the connections in and out of any plugins which 
are present can be seen and modified.  An example of this window is shown in Figure 7 and 
permits custom connections of the in and out ports to the plugins to be made, addition and 
connection of sidechain inputs, MIDI Controls (where available) and so on.  This option will not be 
shown if the channel has no plugins inserted.

Figure   7  : PLUGIN PIN CONFIGURATION WINDOW
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"Protect Against Denormals" has to do with how computers process very small floating-point 
numbers. In normal operation, this mode should be turned off. If a 3rd party plugin is causing 
unusually high CPU load, checking the box may reduce the load.

2.2.2 Channel Redirect Section

Right clicking in this area allows addition of signal processing plugins, inserts and external 
sends, as shown in Figure 8.

Signal flow in the channel strip is as depicted, top to bottom, in the redirect area.  The channel 
main fader is present by default.  The relative positions of the fader, plugins and external sends 
may be rearranged simply by dragging the items up or down in the redirect area.  For example, in
Figure 8 the XT-EG expander plugin on channel GVC F may be placed pre-fader by dragging it 
above the fader (or dragging the fader below it).
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Figure   8  : CHANNEL REDIRECT SECTION

Selecting the Plugin Selector allows insertion of a wide variety of built-in and user-installed 3rd 
party plugin processors.
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Before the Plugin Selector opens, the user will be prompted to scan for third-party plugins, as 
shown in Figure 9.

Figure   9  : OPENING THE PLUGIN SELECTOR

Figure 10 shows the Plugin Selector.  At the top is a list of the currently installed plugins.  
Check boxes allow individual plugins to be flagged as favorites.  Clicking on a plugin selects it and
lights up the "Add" button.  When pressed, the plugin will be added to the lower right box which 
will hold the list of plugins to be inserted.

When there are large numbers of plugins installed it may be difficult to find the desired one.  
The Plugin Selector provides a Search facility with a number of filter options to aid in finding a 
plugin.  As seen in the figure, filters include

 filtering by type, for example effects, instruments or utilities
 filtering by format, for example VST3, LV2, etc is provided by selecting the pulldown
 filtering by creator, such as the Ardour Community, Harrison, etc by selecting the 

pulldown

The Search facility provides for seaching a plugin by:

 name
 tags (which are shortcut IDs associated with every plugin)

Searching may ignore the filters by clicking on the "Ignore Filters when Searching" button.
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Figure   10  : PLUGIN SELECTOR

Selecting "New External Send" will bring up the routing tool.  Using this tool the channel signal 
can be routed anywhere, to a bus or to an external output.  Figure 11 shows the routing tool.  The 
tabs on the right side select general destinations such as buses, external hardware (or network 
connections) and so on.

See Section 3 for more details about the Routing tool and its use.
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Figure   11  : CHANNEL EXTERNAL SEND
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2.2.3 VBM Channel Strip - Signal Processing

Each channel strip has a comprehensive set of signal processing tools.  These are:

 3-band EQ with highpass filter
 leveler
 de-esser
 de-noiser

Single-clicking on the "VBM Strip" button above the program bus assign buttons opens the 
signal processing tools on all channel strips and output buses.  Signal processing on the channel 
strip is shown in Figure 12.  The signal processing parameters may be modified by clicking and 
dragging on the buttons and knobs directly.
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Figure   12  : SIGNAL PROCESSING ACCESS
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Figure 13 shows details of the channel strip signal processing section.  Features of the 
processing section are as follows.

 Input gain trim: the slider on the right sets the input gain to the processing section, it has
a range of –20 to +30 dB of gain.  This control should be the first step in balancing a mix
since it will facilitate managing mix minus and program levels.  Beside the gain trim 
control is a meter indicating signal presence and level, it measures at the channel strip 
input before the fader or any plugins.  Only one meter bar is displayed, on a stereo input
strip it will indicate the level of the sum of the 2 input signals.  

 De-noiser: The denoiser removes unwanted broadband noise and is tailored for use on 
dialogue. The knobs adjust the depth of the denoising in the high and low frequency 
bands, with a range of 2dB to 18 dB. The "Noise" button turns the processing on and 
off. The slider on the left adjusts the overall degree of the de-noising from 0dB  to –40 
dB.  The meter bar indicates the instantaneous amount of the de-noising.

 De-esser: The de-esser has a range of 2dB to 18 dB attenuation adjusted by the 
"Depth" knob.  The Frequency knob adjusts the de-essing corner frequency from 500 to 
4 KHz.  The "Ess" button turns the processing on and off.  The slider at the left adjusts 
the de-essing threshold.  The meter bar indicates the instantaneous amount of the de-
essing.

 Leveler: The Leveler is a compressor with a low fixed ratio and release time. It is 
designed to gently smooth out the peaks in a wide range of signals. The slider on the 
left adjusts the limiting threshold from 0 dB to -40 dB. The Attack knob sets the attack 
time over a range of 4ms to 100 ms. The Gain knob provides makeup gain over a range
0dB to 20 dB. The "Lvl" button turns the processing on and off.  The meter bar indicates
the instantaneous amount of gain reduction.

 Equalizer: The 3 band semi-parametric equalizer operates over the following ranges:

o LOW: +/-15 dB boost/cut over range 40 Hz to 400 Hz, bell response
o MID: +/-15 dB boost/cut over range 200 Hz to 4 kHz, bell response
o HI: +/-15 dB boost/cut over range 800 Hz to 15 kHz, bell response

 High Pass Filter: 12 dB/octave filter adjustable from 200 Hz to 1 KHz
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Figure   13  : CHANNEL STRIP PROCESSING

2.2.4 Program Bus Assign Buttons

The program bus assign buttons do as their name implies, they assign the post-fader channel 
output to one or more of the 4 program buses.  There is an option for additional dedicated gain 
trim and pan knob from each channel at the top of each bus strip, see Section 2.4.1.5.

Operation is slightly different between Contributors (channels which have an associated 
MixMinus bus) and regular inputs (channels which do not).

On Contributor channels when a program bus is assigned but the fader is down (off), the 
button is circled in colour as shown in Figure 14.

Whenever the fader is open, the buttons will turn solid colour as shown in Figure 15.

Regular input channels will always display the program bus assign buttons in solid colours as 
in Figure 15, even if the fader is all the way down.
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Figure   14  : PROGRAM BUS ASSIGN BUTTONS
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Figure   15  :  PROGRAM BUS BUTTONS WITH FADER OPEN

Program bus sends are interlinked with MixMinus bus sends.  When a program bus is 
assigned, sends to the MixMinus buses are also enabled.  When the fader is up, signal also goes 
to all MixMinus buses of channels assigned to the same program bus EXCEPT the one 
corresponding to this input strip (this is the "minus" function).  If no program buses are assigned, 
bringing the fader up will NOT send signal to any MixMinus buses.  However signal will still go to 
any post fader external destinations that have been created.
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2.2.5 Lobby Assign Buttons

Four "Lobby" assign buttons are provided to facilitate *off-air* conversation between principals.
They are mutually exclusive, only one Lobby may be selected at a time.

Lobby selections operate differently for Contributor channels than with regular input channels.  
On Contributor channels Lobby selections are mutually exclusive with the program buses.  When 
the fader is down, Lobby sends are active and program bus send is inactive as shown in
Figure 16.  When the fader is up, Lobby sends are inactive and program sends are active as 
shown in Figure 17.

Figure   16  : LOBBY-PROGRAM ACTIVENESS WITH FADER DOWN

On normal (non-contributor) input channels Lobby selections operate as an additional program
bus, signal can be assigned to either program bus or lobby, or both.  When the fader is down, 
Lobby and program sends are inactive, i.e. both sends are post-fader.
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Figure   17  : LOBBY-PROGRAM ACTIVENESS WITH FADER UP

2.2.5.1 Contributor Operation

Normally, when the fader is up a Contributor channel strip's audio only goes to MixMinus 
buses corresponding to channels assigned to the same program bus.

 when channels are assigned to the same Lobby, a channel strip's audio will be present 
on all MixMinus buses corresponding to other Lobby channels even when the fader is 
down, and remains on those MixMinus buses assigned to the same program bus when 
the fader is up.

 channels assigned to the same Lobby but different program buses will hear a channel's 
audio on their corresponding MixMinus buses only when that channel's fader is down.  
When the channel fader is up, audio from that channel to other channel's corresponding
MixMinus buses not assigned to the same program buses will be cut.

 channels assigned to the same Lobby will appear in a particular channel's 
corresponding MixMinus bus only when that channel's fader is down.  They will be cut 
from that channel's MixMinus bus when its fader is raised.
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2.2.6 Pan/Balance Control

As mentioned at the beginning of Section 2.2 mono input channels have a Pan control and 
stereo input channels have a Balance control.  The pan/balance control setting from the channel 
strip is common across all Program and MixMinus bus destinations.  However the pan/balance at 
any particular bus can be unlinked in the Bus Sends section of Program or MixMinus buses.  See 
Section 2.4.1.5 for details.

 
On stereo input channels the balance control adjusts the relative levels of the left and right 

channel strip outputs to the buses.  At centre the signal levels to the left and right sides of the 
buses is 50% of the channel level.  Sliding the panner full left will send 100% of the channel left 
side to bus left and 0% of channel right side to bus right, and vice versa.

On mono input channels, the mono signal is sent to bus left and bus right according to the 
position of the slider.

2.2.7 Channel Slate

The channel slate is a name plate the same as the name plate at the top of the channel.  
Right-clicking on the slate brings up the same options shown in Figure 5.

2.2.8 Mute and Solo Buttons

Engaging the Mute button mutes all outputs from the channel strip.

Engaging the Solo button solos the channel on the monitor output.  Active channel sends and 
outputs are not affected.  The solo mode (for example, PFL or AFL)  is globally selected on the 
Monitor strip (see Section 2.5).  The button displays the selected solo mode, for example in some 
of the preceding figures the button shows as "PFL" because that is the selected mode.  However, 
the button will instead show "AFL" if that mode is globally selected.

2.2.9 Level Displays

The two side-by-side readouts show numerically the fader setting (left one) and the output 
meter reading (right one).  If the output level ever exceeds 0 dBFS and clips, the output level 
readout will turn red.  After you have corrected the level issue, clicking on the readout will clear the
clip indication. 

2.2.10 Fader

The fader controls the channel strip output level to the Program buses.  It also has a horizontal
bar indicating nominal level (0dB gain).
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2.2.11 Meter

The meter reads the signal level directly in dBFS.  The metering point in the signal flow is 
selectable using the selector button at the bottom of the meter, explained in the next section.  If 
the channel strip is mono (such as for a single microphone) there will be only one bargraph meter.
If the channel strip is stereo (such as from a playback) there will be two bargraph meters for left 
and right, as seen in some of the previous figures above.

2.2.12 Metering Point Select Button

The metering point defaults to pre-fader but can be changed via the meter source button, as 
shown in Figure 18.

Figure   18  : METERING POINT SELECTOR

Five metering point options are available:

 Input – the raw input to the channel strip, before any processing
 Pre Fader – the point immediately before the fader, after any plugin processors
 Post Fader – the point immediately after the fader
 Output – the output of the Channel strip.  This may be a different point than post fader if

any post fader plugins are inserted.  See Figure 19 for an example of a plugin inserted 
post-fader.

 Custom – this allows the metering point to be placed anywhere in the signal flow.  See
Figure 19 for an example.
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Figure   19  : CUSTOM METERING POINT

In the figure, the custom metering point is between the first two plugins before the fader.  As 
with any plugin (or the fader itself), its position in the signal flow can be changed simply by 
dragging it up or down.

2.2.13 Group Assign Button

Grouping of input channels allows two or more channels to have their control functions, such 
as fader and mute, linked together.  For example, grouped channels have all of their faders move 
together when the fader on one of the channels is grabbed and moved.

Grouping is created by clicking on the Group button, as shown in Figure 20.

Figure   20  : GROUPING
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When a new Group is created, a menu is presented allowing selection of which functions are 
to be controlled together, as shown in Figure 21.

Figure   21  : CONTROL GROUPING OPTIONS

Click "New" to create a new Group with the checked control options.

2.2.14 VCA Assign Button

When VCA masters exist, the "VCA" button is present on all channels and bus masters and 
provides assignment to any VCA master.  Individual channels and bus masters may be assigned 
to more than one VCA master.  When VCA master assignment has been made the "VCA" button 
is replaced by buttons showing which VCA master is assigned.

Figure 22 shows an example.  Channel "DDR2" is not assigned to any VCA master, "APB1" 
and "APB2" are assigned to both VCA masters, and "VMix6" is assigned only to VCA master 1.
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Figure   22  : VCAs

Clicking on the VCA assign button will allow additions or changes to VCA assignments, as 
shown in Figure 23.  VCA assignments or deassignments are made by clicking in the check 
boxes.  The "Unassign All" option simultaneously disconnects the channel or bus master from all 
VCA masters it is assigned to, and does not appear when the channel is not assigned to any VCA 
master.
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Figure   23  : CHANNEL ASSIGNMENT TO VCA MASTER

2.3 VCA Masters

Figure 24 shows a VCA master.  VCA masters are created by clicking on the "Add VCA" 
button at the top of the input section, as was shown in Figure 2.  The number of VCA masters that 
can be created is unlimited.  Any input channel, Program bus master or MixMinus bus master may
be assigned to a VCA master.

The fader provides master level control of all assigned channels or buses, with the amount of 
gain or attenuation displayed in the indicator window.  The Spill button reduces the control panel 
to display only those Input channels or MixMinus buses assigned to this VCA master.  However all
4 Program Bus masters are always displayed regardless of VCA master assignment.
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Figure   24  : VCA MASTER
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The Name Plate provides some options for the VCA master, such as renaming or removing 
assignments from it, as shown in Figure 25.

Figure   25  : VCA MASTER NAME PLATE

Channels or bus masters may be assigned to a VCA master by selecting the channel or bus 
(clicking on it) and selecting "Assign Selected Channels".  Conversely channels or buses may be 
removed from VCA control by selecting  "Drop Selected Channels".  "Drop All Slaves" disconnects
ALL channels or bus masters assigned to the VCA master.

The "M" and "P" buttons are master mute and solo for all channels or bus masters assigned to 
this VCA master.  The "P" button will group solo all assigned channels or bus masters.  The "M" 
Button simultaneously mutes all channels or bus masters assigned to this VCA master.  In both 
cases the affected channels or masters will have their Mute or PFL buttons highlighted with a 
colour ring when the function is active.  This is shown for the Mute example in Figure 26.
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Figure   26  : MASTER MUTE FROM VCA MASTER

2.4 Buses

Figure 27 shows the VBM bus masters.  There are two types of buses:

 Program buses
 MixMinus buses

There are 4 Program buses available.  The number of MixMinus buses is variable, 
corresponding to the number of Contributors created and following their naming.
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Figure   27  : VBM BUS MASTERS
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2.4.1 Program Buses

A Program bus master is shown in Figure 28.  There are 4 basic sections to the Program bus, 
the Redirect/Plugins section, the signal processing section (accessed by the "VBM Strip" button), 
and the fader-meter section at the bottom.  The 4th section, the Sends section, is not shown by 
default so is not shown in the figure, and will be detailed in Section 2.4.1.5.
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Figure   28  : PROGRAM BUS MASTER
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2.4.1.1 Program Bus Nameplate

The Program Bus nameplate is shown in Figure 29 and may be selected by either left or right 
clicking.  The available options have the identical functions as for an Input strip, as presented in 
Section 2.2.1.

The additional option here is the "Show Individual Gain Controls" check box.  When selected, 
the bus Sends section is displayed showing individual gain and pan controls, and a signal active 
indicator.  The Sends section will be covered in Section 2.4.1.5.

Figure   29  : PROGRAM BUS NAMEPLATE
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2.4.1.2 Redirect Section

The Redirect section provides for inserting processing plugins and additional sends out of the 
bus strip.  The functioning of this section is identical to that in the Input channel strip, as covered 
in Section 2.2.2.

2.4.1.3 Program Bus Signal Processing

Clicking on the "VBM Strip" button on any input channel or bus master displays the signal 
processing sections on all input channel strips and buses.

The signal processing available on the on buses is slightly different than that on the Input 
strips.  Figure 30 shows the bus signal processing detail.

Figure   30  : BUS SIGNAL PROCESSING

The bus signal processing provided is as follows.

 Leveler: The Leveler is a compressor with a low fixed ratio and release time. It is 
designed to gently smooth out the peaks in a wide range of signals. The slider on the 
left adjusts the limiting threshold from 0 dB to -40 dB. The Attack knob sets the attack 
time over a range of 4ms to 100 ms. The Gain knob provides makeup gain over a range
0dB to 20 dB. The "Lvl" button turns the processing on and off.  The meter bar indicates
the instantaneous amount of gain reduction.

 Equalizer: The 3 band equalizer operates over the following ranges:

o LOW: +/-15 dB boost/cut shelving response, 125 Hz corner frequency
o MID: +/-15 dB boost/cut bell response, 900 Hz centre frequency
o HI: +/-15 dB boost/cut shelving response, 3200 Hz corner frequency

40



MIXBUS VBM 3 April 2023

2.4.1.4 Lower Section

The lower section of the Program bus strip is identical to that of the Channel strip, and all 
indicators and controls operate identically to those on the Input channel strip.

These are:

 Panner
 Bus Slate
 Bus Mute and Bus PFL buttons
 Fader and Output level displays
 Fader
 Bus metering
 Group selector
 Metering point selector
 VCA assign button (present *if* VCAs have been created)

Review Sections 2.2.7 through 2.2.14 for details on the operation of this section of the 
Program bus strip.

2.4.1.5 Sends Section

If the "Show Individual Gain Controls" box shown in Figure 29 is checked, the Sends section 
will be displayed.  The Sends section provides additional level control and pan capabilities from 
each Input and Contributor channel routed to this Program bus.  Figure 31 shows the Program 
bus master with the Sends section displayed.

41



MIXBUS VBM 3 April 2023

Figure   31  : PROGRAM BUS MASTER SHOWING SENDS SECTION

42



MIXBUS VBM 3 April 2023

The Sends section is shown in detail in Figure 32.  This section has the controls and indicators
related to audio sends from the channel strips.

 the Slider Bar will appear when the number of Input channels exceeds the available 
display height.  Drag the slider bar up and down to display the sends not visible

 the Sends Controls provide gain trim, panning to program, and audio live indicators for 
each Input channel assigned to this Program bus.

Figure   32  : PROGRAM BUS SENDS SECTION

Figure 33 shows details of the Channel send controls.  The send from *each* input channel 
has the following:

 gain trim – this horizontal slider provides for gain trimming of the signal from the Input 
channel.  Gain is adjustable from fully OFF to +6 dB.

 live audio indicator – this is an indicator which will light up as shown whenever the fader
on the Input or Contributor channel is up.  It is not a signal presence indicator.

 pan/balance knob – the Program bus is always stereo.  When the Input channel is mono
this knob functions as a pan knob to the stereo Program bus.  When the Input channel 
is stereo this knob functions as a balance control.
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Figure   33  : CHANNEL SENDS CONTROLS

The Pan/Balance knob can operate in 2 different modes.  In Figure 34 note the position of the 
panner on input "GVC F" and on the "GVC F" send on program bus P2.  The pan/balance knob on
P2 is gray in colour indicating it is linked to the panner on "GVC F", indicating 71% Left and 29% 
Right.  They will track when either one is adjusted.

Figure   34  : BUS PANS LINKED

44



MIXBUS VBM 3 April 2023

Right clicking on the pan/balance knob on the "GVC F" send on program bus P2 will change its
colour to red, indicating the panning of this input is now uncoupled from the panner on the channel
strip.  This can be seen in Figure 35 where it can be seen the panning on the channel strip panner
is still 70% Left and 30% Right, but the panning of "GVC F" to program bus P2 is now set to 33% 
Left and 67% Right.

This capability can be used to individually set a channel's panning to each Program or 
MixMinus bus.  NOTE that the signals to be panned are derived PRE the panner on the channel 
strip.

Figure   35  : BUS PANS UNLINKED

The Sends section provides the capability to customize the mixes on each MixMinus and 
Program bus.  However these are advanced features and must be used with considerable caution 
otherwise you will end up with an unexpected mix.  For example, turning off a send level here will 
defeat the function of the associated channel fader to ALL of its destinations.
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2.4.2 MixMinus Buses

A MixMinus bus master is shown in Figure 36.  As with the Program bus master it has 4 basic 
sections, the Sends section at the top, the Redirect/Plugins section, the signal processing section,
and the fader-meter section at the bottom.

The 4 sections of the MixMinus bus master operate identically to those on the Program bus 
master, with the exception of the automatic mix minus operation of the channel sends.

Unlike the Program bus masters, the MixMinus bus masters have the Sends section displayed 
by default, and the ACE IFB plugin is inserted by default. See Appendix 1 in Section 6 for details 
of the ACE IFB plugin.
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Figure   36  : MIX MINUS BUS MASTER
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2.4.2.1 Sends Section

The Sends section is identical to the Sends section on the Program buses.  The only 
differences are in the operations of the bus under certain bus assignment conditions as follows:

 the send from the corresponding Contributor channel is NOT PRESENT, to prevent a 
feedback loop.  In Figure 36 showing the MixMinus bus master for GVC A, note that the 
send from GVC A is missing.

 When Input Channels are assigned to Lobbies, the audio flow is as described under 
Lobby operation in Section 2.2.5.1.

2.4.2.2 Show Sends Button

The Show Sends button enters a mode where level control of all Input and Contributor 
channels feeding this MixMinus bus will be controllable on their individual channel faders.  When 
selected, only this MixMinus bus master is displayed.

In this mode the Show Sends button will flash, as shown in Figure 37.

Figure   37  : MIX MINUS BUS SHOW SENDS MODE
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2.4.2.3 Redirect Section

The Redirect section on the MixMinus bus operates identically to the corresponding sections 
on the Input channel and the Program buses, and provides for inserting processing plugins and 
additional sends out of the bus strip.  The functioning of this section is identical to that in the Input 
channel strip, as covered in Section 2.2.2.

As shown in Figure 36, the ACE IFB plugin is inserted ahead of the fader by default on all 
MixMinus buses.  Double clicking on the button will bring up the plugin's control panel.  See 
Appendix 1 in Section 6 for details.

2.4.2.4 Program Level Slider

The Program Level slider controls the amount of Program level in the MixMinus output.  The 
signal originates on whatever Program bus the Contributor input channel is assigned to.

2.4.2.5 Signal Processing Section

Clicking on the "VBM Strip" button displays the signal processing sections on all input channel 
strips and buses.

The signal processing available on the MixMinus buses is identical to that on the Program 
buses.  

2.4.2.6 Lower Section

The lower section of the MixMinus bus strip is identical to that of the Channel and Program bus
strips, and all indicators and controls operate identically to those on the Input channel strip.

These are:

 Panner
 Bus Slate
 Bus Mute and Bus Solo buttons
 Fader and Output level displays
 Fader
 Bus metering
 Group selector
 Metering point selector
 VCA assign button (present *if* VCAs have been created)
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Review Sections 2.2.7 through 2.2.14 for details on the operation of this section of the 
MixMinus bus strip.

2.5 Monitor Strip

The VBM Monitor strip is shown in Figure 38.  The monitor strip typically feeds the broadcast 
engineer's monitor speakers or headphones.
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Figure   38  : VBM MONITOR STRIP
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Indicators and controls are as follows:

 Monitor Selector – this selects where the Monitor Strip is monitoring from.  Monitoring 
point can be set to anywhere in the VBM, as shown in Figure 39.

 Solo Indicator/button – this button flashes whenever there is an active solo as shown 
in Figure 40.  Click on the flashing button to clear the solo.

 Isolated indicator/button – this button is lit when a channel or bus strip is isolated from
soloing.  Click on the button to de-isolate.
"Solo Isolate" is a mode which prevents a channel from muting when other channels are
solo'd. Ctrl-click (Cmd on a MAC) on a channel to solo-isolate it.

 Pre Fader Listen – Solo monitors pre the channel or bus fader
 After Fader Listen – Solo monitors post channel or bus fader
 Exclusive Solo – when engaged (and the indicator is lit) only one soloed source will be 

heard at a time.  Normally all soloed sources will be heard together.
 Solo >> Mute - when engaged, solo overrides mute.  Muted sources will also be heard 

in solo.
 Redirect Section – allows for insertion of signal processing plugins in the monitor path
 Solo Boost - this knob adds additional gain to a soloeed source.  The button allows 

quick presetting of the amount of boost to 3, 6 or 10 dB
 DIM - this knob sets the amount of monitor attenuation when the "Dim" button is 

engaged.  The button allows quick presetting of the amount of attenuation to -3, -6, -12 
or -20 dB

 L-R Controls – These buttons allow mute, dim, solo or invert of the main left and right 
monitor outputs

 Mono – sums left and right monitor paths to both outputs
 Mute – cuts all audio output from the monitor section
 Monitor Attenuator – this is the volume control for your monitoring speaker output.  

The button allows quick presetting of the level to –3, -6, -12,-20 or –30 dB
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Figure   39  : MONITOR SELECTOR
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Figure   40  : MONITOR STRIP IN SOLO
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2.6 Meterbridge

2.6.1 Accessing the Meterbridge

The Meterbridge is called up through the Window tab, as shown in Figure 41.

Figure   41  : ACCESSING THE METERBRIDGE

2.6.2 Meterbridge Features

The Meterbridge not only provides all of the channel and bus metering in one place, but can 
also function as a mini-control panel which can cover the most used functions during a live 
broadcast.

Figure 42 shows the Meterbridge for a typical session.

The Meterbridge window will nominally be on top of the main VBM window.  It can also be 
dragged to a second video monitor if available.  When accessing the main window it may 
disappear behind the main VBM window on some computer platforms.  To restore the Meterbridge
on top, just click anywhere on the main VBM window and it will appear.  However to adjust the 
controls on the Meterbridge window, it is necessary to click on it to select it as the focus window.
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Figure   42  : METERBRIDGE

The features of the Meterbridge window are as follows:

 Meters: These are copies of the meters on the channel strips and bus masters.  As 
discussed in Section 2.2.12 the metering point displayed is whatever the channel strip 
or bus master metering point is set to, including custom metering points.

 Mute buttons:  These are copies of the Mute buttons on the corresponding channel or 
bus master strips.

 Solo buttons: These are copies of the Solo buttons on the corresponding channel or bus
master strips.  In the figure soloing is set to PFL so the button labels are "P".  If the 
global solo mode was set to AFL, these buttons would be labeled "A".

 Fader knobs: clicking and dragging on these knobs moves the associated channel or 
bus master fader.

With this set of controls the operator has everything needed to monitor and run the most 
common operations of the broadcast, with everything displayed at once in a compact window.  
The main VBM window need only be accessed if routing, processing or other usually constant 
items need changing. 
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3.0 Routing Tool

The Routing Tool manages all of the audio connections hidden beneath the control window of 
VBM.  It is accessed from selecting "Audio Connections" from the "Window" pulldown as shown in
Figure 43.

Figure   43  : ROUTING TOOL ACCESS

One example of the Routing Tool is shown in Figure 44.  With the Routing tool any desired 
audio connections may be made.  It is used particularly for connecting Channel inputs and Bus 
outputs to physical I/O hardware (or network I/O) .

The tool is organized as a matrix, with sources vertical and destinations horizontal.  Clicking on
a square in the matrix establishes an audio connection.  There are multiple tabs on both axes for 
selecting different groups of sources and destinations.  For example the figure shows VBM buses 
selected as both sources and destinations.  No connections are present.  However, imagine you 
needed to feed the output of Program 1 into Program 4  for some reason.  By simply clicking in the
boxes, such a connection could be established, as shown in Figure 45.

As a final example, Figure 46 shows the default connection of the Monitor strip output to some 
external hardware interface.  It should be obvious that the interface could be fed directly from any 
other bus output if desired, including the Master bus.
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Figure   44  : ROUTING TOOL
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Figure   45  : SHOWING A PROGRAM BUS TO PROGRAM BUS CONNECTION
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Figure   46  : MONITOR STRIP CONNECTION TO EXTERNAL INTERFACE
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4.0  Summary

This document has presented an overview of the features of the Harrison Mixbus VBM virtual 
broadcast mixer.

This document will be refined and updated as additional features and capabilities are added to 
Mixbus VBM.
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5.0 References

1. Harrison Mixbus 32C v7 online manual.

2. Harrison Mixbus 32C v6 online manual.
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6.0 Appendix 1: ACE IFB Plugin

6.1 Description

The ACE IFB plugin is automatically inserted on all MixMinus buses when they are created.

This plugin is the mechanism to provide talkback audio to the contributor. The plugin itself is a 
4in x 2out mixer/ducker. Stereo mix minus audio comes in through 2 inputs.  Talkback/comms 
sources are fed to the other 2 inputs. The plugin will then duck the mix minus audio based on the 
threshold setting when the talkback happens.

6.2 Use

As on any plugin in VBM, double-clicking will bring up its control panel as shown in Figure 47.  
The control parameters for the ducker are self evident.  Shown is the control panel for the plugin 
on MixMinus bus GVC A.

The ducking function requires connections to the sidechain inputs in order to operate.  These 
can be attached through the Pin Connections window, accessed either by right clicking on the 
plugin in the bus redirect section, or by clicking on the pin connection button in the plugin control 
panel, as shown in Figure 47.

The pin connection window is shown in Figure 48.  Note the 4 inputs at the top of the plugin, of
which 2 are the through audio paths and are automatically connected, and 2 are sidechain inputs. 
Thus, the ducker function can be controlled from 2 different sources.

To add a sidechain input to operate the ducker, click on the "Sidechain" button and 
selector/deselector buttons will appear.  A wide selection of signals present in VBM can be chosen
to feed the sidechain input, as shown in Figure 49.  Also note the addition of the arrow on the right
which is the input from the selected sidechain source.

The final step is shown in Figure 50.  Here program bus P4 is selected as the sidechain input 
and a level slider is also made available.  Also note, on program bus P4 the send is now shown 
and also has a level slider.  As with any other plugin on P4, the sidechain feed to MixMinus bus 
GVC A can be positioned anywhere in the P4 bus signal path simply by dragging it up or down.
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Figure   47  : ACE IFB PLUGIN CONTROL PANEL

Figure   48  : ACE IFB PIN CONNECTIONS WINDOW
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Figure   49  : ACE IFB - ADD SIDECHAIN INPUT

The actual sidechain connection is made by simply clicking on the sidechain source arrow on 
the right, and dragging the connection to one of the sidechain inputs.
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Figure   50  : ACE IFB SIDECHAIN INPUT CONNECTION
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7.0 Appendix 2: Installation and Licensing

Mixbus VBM is a licensed product.  In order for VBM to operate the license file must be 
resident in your computer's HOME folder.

7.1 Getting Started

Follow these steps to install the VBM program and its license file on your computer.

7.1.1 Installing The Software

1. Depending on the type of computer there will be different installation files.  For example:

 Windows
The program is a .exe file such as MixbusVBM-1.1.112-w64-Setup.exe

 MAC
The program is a .dmg file such as MixbusVBM-1.1.112.dmg

 Linux
The program is a .tar (tape archive) file such as MixbusVBM-1.1.112-x86_64-gcc5.tar

 

Install the program as you would install any other application on your computer.

2. Install the license.

This is done by saving the attached license file to the home folder of the computer. The home 
folder is the one that contains the Downloads and Documents folder and is normally a user name. 

On Windows:  You can locate the folder quickly by entering %USERPROFILE% in the 
search/address bar of a windows file explorer window. 

On MacOS: From the finder menu, select "Go" and then "Home" 

On Linux:  The license file goes in the user's HOME directory
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3. Launch MixbusVBM 

4. Click "New Session" 

5. For the initial test, just use the default generated session name and click open.  When you 
create your actual working session you can choose any name you want.

6. You will need to configure an audio device for MixbusVBM to use. If you are running local 
I/O (example a USB interface) then select that. For cloud applications with NDI you can just 
choose any available sound card for the Input and Output devices. If you are using Dante, then 
select the Dante Virtual Sound Card. Once you have picked your device click start. 

7. You will now see the empty mixer with just the Programs and Monitor section.

8. If you want to use NDI or other plugins you will need to have them installed on the system 
and then have MixbusVBM scan them. From the Window menu, open the "Plugin Manager" and 
then click the "Re-scan All" button 

9. For a quick test session, click the template button on the top left and then click OK. This will 
generate an NDI based setup with 2 contributor channels and 12 input channels. This template is 
configurable by us, so we can customize it to suit your needs in the future.

7.1.2 Checking Licensing Status

Information about the Mixbus VBM version, licensing status and license owner can be viewed 
from the "Help -> About" pulldown at the top of the Mixbus VBM window, as shown in Figure 51.

Figure   51  : ACCESSING VERSION AND LICENSING INFORMATION

The About window will look like that in Figure 52.
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Figure   52  : ABOUT WINDOW
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8.0 Appendix 3: Release Notes

8.1 v1.2 to v1.2.9

 Added support for 24 and 32 fader iCON QCon Pro X setups
 Fixed a bug in the channel labels for the QCon Pro X extenders that caused the 2nd LCD 

text to not line up with the faders
 Added an audio delay plug-in called "Mega Delay Line" which can be used for delaying 

audio to sync with video
 Added a fader knob to the Meterbridge window. This allows the Meterbridge window to 

server as a compact overall mixer view

8.2 v1.1.112 to v1.2

 Session Compatibility - Fixed bug that was loading wrong version of the channel strip DSP on 
MM and Program channels

 Fixed meter scale for channel strip input meter
 Added preferences option to show input/trim and phase controls on mixer strips. Sessions 

made with v1.1.112 will need reset local preference to get the default state (hidden).
 Removed Automation controls from generic plugin parameters dialogs.
 Update EULA to inform users that the online license system collects IP addresses and other 

identifying information
 Added licensee and status information to About page
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8.3 v1.17 to v1.1.112

 Added Harrison DSP to the mixer strips
o Contributor/Input channels: Denoiser, Desser, Leveler, 3 Band Parametric EQ with HPF

 Mix Minux/Program channels: Leveler, 3 Band Fixed Frequency EQ (High/Low Shelf, 
Mid Bell)

 Added Program level control to mix minus channels and auto hide sends that are part of the 
program

 Added option to show all level controls on the Mix Minus channel
 Added support for running with local I/O by always monitoring the input of contributor/input 

channels
 Program matrix mixer his hidden by default. I can be enabled by right clicking the program 

channel slate and selecting "Show Individual Gain Controls"
 Default output meters to dBFS (0dB) scale
 Mix Minus channel names follow the contributor track name automatically
 Fixed a bug that caused audio glitches when mixer strip processors changed order

************************************** END OF VBM USER MANUAL  **************************************
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